
Microsoft Offi ce Integration 2007 

1 Integrating Offi ce 
2007 Applications and 
the World Wide Web

Objectives
You will have mastered the material in this chapter when you can:

• Integrate the Offi ce 2007 
applications to create a Web site

• Add hyperlinks to a Word document

• Embed an Excel chart into a Word 
document

• Add a hyperlink to a PowerPoint 
slide

• Create Web pages from a 
PowerPoint presentation

• Add a hyperlink to an Access report

• Create a Web page from an Access 
report

• Test a Web site in a browser
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Introduction
Integration means joining parts so they work together or form a whole. In information 
technology, common usages can include the following: 

1. Integration during product development combines activities, programs, or 
hardware components into a functional unit.

2. Integration in manufacturing can bring different companies’ products together 
into an effi ciently working system. 

3. Integration in marketing combines products or components to meet objectives 
such as sharing a common purpose or creating demand. It includes such matters 
as consistent product pricing and packaging, advertising, and sales campaigns.

4. Integration in product design allows a unifying purpose and/or architecture, such 
as the Microsoft Offi ce System. (The products also are sold individually, but they 
are designed with the same larger objectives and/or architecture.)

This Integration chapter will show you how you can use the functionality and pro-
ductivity tools of the Microsoft Offi ce System.

Project — Integrating Offi ce 2007 Applications and 
the World Wide Web
Many businesses advertise their products and services on the Internet. Companies fi nd it 
easy to create Web pages using information already saved in word processing, spreadsheet, 
database, or presentation software formats. The Web pages shown in Figure 1–1 include 
information about the Makin-It Real Estate Company. This small business specializes in 
selling homes near the local college campus to fi rst-time homebuyers. The owners of the 
business want to advertise their services and homes for sale on an attractive Web page. 

The project in the chapter follows proper design guidelines and uses Offi ce 2007 
applications to create the Web pages and other documents shown in Figure 1–1. The 
Web page creation capabilities of Microsoft Offi ce 2007 make it simple for you to create 
an entire Web site using the information available. Word allows you to create and save 
a document as a Web page. Word also allows you to embed an Excel chart in a docu-
ment, which can be included in a Web page. PowerPoint provides the same capability and 
adds a navigation structure for browsing. In addition, an Access report can be saved as a 
Web page so that users can view database contents online. Several sources of information 

Microsoft Offi ce Word 2003Microsoft Offi ce Integration 2007

1 Integrating Offi ce 2007 
Applications and the 
World Wide Web

INT 2
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already exist that can be benefi cial to creating a Web page. The following four fi les of 
information are supplied to help you get started:

1. A Word document that contains the company letterhead, including logo images, 
company name, and company address (Figure 1–1a on page INT 4).

2. An Excel workbook with a Bar chart graphically illustrating the company’s 
breakdown of home sales per year (Figure 1–1b on page INT 4).

3. A PowerPoint presentation that contains general information about the company’s 
services (Figure 1–1g on page INT 5).

4. An Access database containing information about homes that currently are for 
sale through the company (Figure 1–1c on page INT 4).

The Makin-It Real Estate Web site should include the following:

1. A home page with a Bar chart that contains the homes sold by the company per 
year (Figure 1–1e on page INT 5). Three hypertext links also are included on the 
home page: Company Services, Homes for Sale, and E-mail for Information.

2. The Homes for Sale Web page (Figure 1–1d on page INT 4) is created from the 
Access fi le. Clicking the Homes for Sale link on the home page accesses this Web 
page. On this Web page, visitors can view the homes for sale from the 
company, categorized by the type of home.

3. The PowerPoint Web page (Figure 1–1g on page INT 5) displays information 
about services provided by the company. Clicking the Company Services link on 
the home page accesses this Web page.

4. Using the E-mail for Information hyperlink, you can create an e-mail message 
(Figure 1–1f on page INT 5). E-mail is sent to the e-mail address 
manager@isp.com.

Overview
As you read this chapter, you will learn how to create the Web pages shown in 

Figure 1–1 by performing these general tasks:
• Insert hyperlinks in the Word document
• Embed the Excel chart in the Word document
• Save the Word document as a Web page
• Add a hyperlink to the PowerPoint presentation
• Save the PowerPoint presentation as a Web page
• Create the Access report
• Add a hyperlink to the Access report
• Save the Access report as a Web page
• Test the Web site
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INT 4   Integration Chapter 1   Integrating Offi ce 2007 Applications and the World Wide Web

Figure 1–1

(a) Word Document 

(b) Bar Chart in Excel

(c) Access Table

(d) Access Report Saved as Web Page

logo images

heading
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(e) Word Document Saved as Web Page

(f) New E-Mail Message Created from Hyperlink

(g) PowerPoint Presentation Saved as 
 Web Page

Project — Integrating Offi ce 2007 Applications and the World Wide Web   INT 5
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INT 6   Integration Chapter 1   Integrating Offi ce 2007 Applications and the World Wide Web

Adding Hyperlinks to a Word Document
The Web site created for Makin-It Real Estate consists of an initial Web page, called the 
home page, (Figure 1–1e on the previous page) with two hyperlinks to other Web pages, 
an e-mail link, and a Bar chart. Clicking a hyperlink, which can be text or an image, 
allows you to jump to another location. Text is used (Company Services, Homes for Sale, 
E-Mail for Information) for the three hyperlinks on the Makin-It Real Estate home page. 
The fi rst hyperlink (Company Services) jumps to a PowerPoint Web page that contains 
three Web pages that explain the services offered by the company. A second hyperlink 
(Homes for Sale) jumps to an Access report that provides a list of homes for sale extracted 
from Makin-It Real Estate’s Homes for Sale Access database. This Web page allows inqui-
ries only; updating the database is prohibited. The third hyperlink (E-Mail for Information) 
creates an e-mail message. In order to place the three hyperlinks to the left of the Bar 
chart, a table will be created in the Word document.

To Start Word, Open an Existing Document, and Save the 
Document with Another Name

The fi rst step in this chapter is to open the Word document, Makin-It Real Estate 
Letterhead, and save it with the new fi le name, Makin-It Real Estate Home Page.

1  Connect the USB fl ash drive containing the Data Files for Students to an available USB port 
on your computer. See the inside back cover of this book for instructions for downloading 
the Data Files for Students or see your instructor for information on accessing the fi les 
required in this book.

General Project Decisions
When creating Web pages from many Offi ce 2007 documents, you need to make several 
decisions that will determine the appearance and characteristics of the fi nished Web pages. 
As you create the Web pages shown in Figure 1–1, you should follow these general guidelines:

1. Choose hyperlink names and locations. Decide upon the names of the various Web 
pages and their location on media before creating the Web pages. For example, the fi rst 
two hyperlinks in Figure 1–1e open Web pages named Company Services and Homes for 
Sale. The third hyperlink, E-Mail for Information, is easily understood by a Web page visitor.

2. Ascertain the navigational structure of the Web pages. The arrows shown between the 
Web pages in Figure 1–1 are an example of a navigational structure. Determine which 
pages link to other pages before the Web pages are created. The navigational structure 
shown in Figure 1–1 is appropriate for a small Web site. 

3. Determine appropriate fi le names for Web pages. File names used for each of the Web 
pages shown in Figure 1–1 need to be determined when planning the pages because the 
fi le names are used to create the hyperlinks that are needed to navigate the Web pages. 
When naming these fi les, appropriate fi le names should be used. Save all Web pages to 
the same location so that they are easier to manage.

4. Organize the layout of the home page. Follow good design and visual layout principles 
to create an inviting home page. The page should not be cluttered, and the user should 
know what to do without the need for instructions. 

5. Plan the layout of the Access report. Follow good Access report design guidelines to 
create the Access report. The fact that the report is to be used as a Web page requires 
additional thought and planning.

Plan Ahead

Web Pages 
Making information 
available on the Internet 
is a key aspect of business 
today. To facilitate this 
trend, the Offi ce 2007 
applications easily allow 
you to generate Web 
pages from existing fi les. 
An entire Web site can be 
created with fi les from 
Word, Excel, PowerPoint, 
or Access by selecting the 
Web Page fi le type in the 
Save As dialog box.

B
T
W
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2  Start Word. Click the Offi ce Button and then click Open on the Offi ce Button menu.

3  Click the Look in box arrow and then click UDISK 2.0 (E:) in the Look in list. (Your USB drive 
may have a different name and letter.)

4  Double-click Makin-It Real Estate Letterhead to open the Makin-It Real Estate Letterhead 
document.

5  Click the Offi ce Button and then click Save As on the Offi ce Button menu. Type Makin-It 
Real Estate Home Page in the File name text box and then click the Save button in the 
Save As dialog box to save the document as Makin-It Real Estate Home Page.

6  Click the Web Layout button on the status bar to view the document in Web layout view 
(Figure 1–2).

7  Click the Show/Hide ¶ button on the Ribbon to show hidden formatting symbols.

Figure 1–2

Web Layout 
view selected

title bar displays 
new fi le name

heading

Makin-It Real 
Estate Home Page 
button on taskbar

logo images

Adding Hyperlinks to a Word Document   INT 7

Show/Hide ¶
button
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INT 8   Integration Chapter 1   Integrating Offi ce 2007 Applications and the World Wide Web

To Insert a Table into a Word Document

The next task is to insert a table with two columns and one row. The left column will contain three hyperlinks. 
The right column will contain the Bar chart. 

The following steps add a table to the Makin-It Real Estate Home Page document.

1
• Position the insertion point on the 

second paragraph mark below the 
company telephone number. 

• Click the Insert tab on the Ribbon 
and then click the Table button on 
the Ribbon. 

• Drag the mouse pointer through 
the fi rst two cells in the Table 
gallery and do not release the 
mouse button (Figure 1–3).

2
• Release the mouse button to 

insert the table and close the 
Table gallery. 

Figure 1–3

Insert tab

Table button

2x1 table 
selected

second paragraph 
mark below heading

2x1 table inserted 
in document

Other Ways

1. Press ALT+N, T
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2
• Click No Border in 

the Borders gallery 
to remove the bor-
ders from the table.

3 
• Click the Layout tab 

on the Ribbon. 

• Click the View 
Gridlines button on 
the Ribbon to dis-
play gridlines in both 
tables in the 
document 
(Figure 1–5). 

When should I use 
gridlines? 

Gridlines can be 
used as a guide 
when entering text 
or images. When the 
document is viewed 
in your browser or 
printed, the gridlines 
do not display or 
print. 

To Remove the Table Border, View Gridlines, and AutoFit the Table Contents

The table border for the new table is not necessary for the Web page. In order to place the contents in the 
document properly, however, gridlines should be displayed to serve as a guide for inserting the hyperlinks and chart. 
The cells in the table also should be formatted to adjust their size automatically to accommodate the data inserted 
in the table. The AutoFit to Contents option allows you to make the columns in a table automatically adjust to the 
contents. The following steps remove the border of the table, display gridlines in the tables in the document, and set 
the AutoFit to Contents option for the table. The heading in the document, including the clip art images, is already 
included in a table. 

1
• Select both cells in 

the new table.

• If necessary, click the 
Design tab on the 
Ribbon.

• Click the Borders 
button arrow on the 
Ribbon to display 
the Borders gallery 
(Figure 1–4).

Figure 1–4

No Border 
command

Borders 
button arrow

Borders 
gallery

table selected

Figure 1–5

View Gridlines 
button Layout tab

gridlines appear 
in tables

Q
&

A
Adding Hyperlinks to a Word Document   INT 9
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INT 10   Integration Chapter 1   Integrating Offi ce 2007 Applications and the World Wide Web

4
• Click the AutoFit button arrow on 

the Ribbon to display the AutoFit 
gallery (Figure 1–6). 

Bubble height
One line bubbles - 1p1
Two-line bubbles - 1p8
Three-line bubbles - 2p3
Four-line bubbles - 2p10

Figure 1–6

AutoFit gallery
AutoFit Contents 
command

AutoFit button

5
• Click AutoFit Contents in the 

AutoFit gallery to shrink the 
selected cells to fi t their contents 
(Figure 1–7).

Figure 1–7

cells shrink because 
no text in cells
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To Insert Text for Hyperlinks

After creating the borderless table, you must insert the three text phrases that will be used as hyperlinks on the 
home page. These phrases (Company Services, Homes for Sale, and E-Mail for Information) allow the Web page 
visitor to jump to two other Web pages and create an e-mail message. The following steps add the text phrases that 
are used as hyperlinks.

1
• If necessary, click the leftmost cell 

in the table to place the insertion 
point in the cell.

2
• Type Company Services and 

then press the ENTER key twice. 

• Type Homes for Sale and then 
press the ENTER key twice. 

• Type E-Mail for Information 
but do not press the ENTER key to 
complete the entry of the three 
text phrases that will be used as 
hyperlinks (Figure 1–8).

Figure 1–8

right-hand 
column of table

Company Services  
text for hyperlink

Homes for Sale 
text for hyperlink

E-Mail for Information 
text for hyperlink

Adding Hyperlinks to a Word Document   INT 11

To Create a Hyperlink to PowerPoint Web Pages

The Insert Hyperlink feature provides the capability of linking to an existing fi le or Web page, to a place 
within the current document, to a newly created document, or to an e-mail address. In this chapter, two hyperlinks 
(Company Services and Homes for Sale) will be created that link to Web pages. The Company Services hyperlink 
will jump to a PowerPoint presentation that is saved as a Web page using the Web page name, CompanyServices.
htm. The Homes for Sale hyperlink jumps to an Access report page using the Web page name, Homes for Sale.htm. 
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INT 12   Integration Chapter 1   Integrating Offi ce 2007 Applications and the World Wide Web

You will create the report later from an existing Access database. The third text phrase (E-Mail for Information) 
links to an e-mail address, allowing the Web page visitor to send an e-mail message to the company’s manager. 

The following steps create a hyperlink for the fi rst text phrase.

1
• Drag through the 

text, Company 
Services, in the table 
to select the text. 

• Click the Insert tab 
on the Ribbon.

• Click the Hyperlink 
button on the 
Ribbon to display 
the Insert Hyperlink 
dialog box.

2
• If necessary, click the 

Existing File or Web 
Page button on the 
Link to bar. 

• Type 
CompanyServices.

htm in the Address 
text box (Figure 1–9).

3
• Click the OK button to 

assign the hyperlink 
to the Company Services phrase. 

How does the hyperlink function? 

After saving the Word document as a Web page, the visitor clicks the text, Company Services, and the 
CompanyServices.htm fi le on the USB fl ash drive is displayed. 

Figure 1–9

OK button

Hyperlink 
button

Existing File or 
Web Page button

Insert Hyperlink 
dialog box

Link to bar

Text to display 
text box

Address 
text box

E-mail Address 
button

Other Ways

1. Right-click selected 
words, click Hyperlink 
on shortcut menu

2. Press CTRL+K

Q
&

A

To Insert the Remaining Hyperlinks

The following steps add the remaining two hyperlinks.

1  Drag through the text, Homes for Sale, in the table. Click the Hyperlink button on the 
Ribbon.

2  Type Makin-It Real Estate - Homes for Sale.htm in the Address text box and 
then click the OK button.

3  Drag through the text, E-Mail for Information. Click the Hyperlink button on the Ribbon 
and then click the E-mail Address button on the Link to bar.

4  Type manager@isp.com in the E-mail address text box. 

5  Type Request for Information in the Subject box and then click the OK button 
(Figure 1–10).
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Figure 1–10

Embedding an Excel Chart into a Word Document
This chapter uses the Object Linking and Embedding (OLE) feature of Microsoft 
Offi ce 2007 to insert the Excel chart into a Word document. OLE allows you to incorpo-
rate parts of a document or entire documents from one application into another. The 
Bar chart in Excel is called a source object (Figure 1–1b on page INT 4) and the Makin-It 
Real Estate Home Page document is the destination document. An embedded object 
becomes part of the destination document. This chapter illustrates using the Paste Special 
command to embed the Excel object. Paste Special inserts an object into Word, but 
still recognizes the source program, the program used to create the object. When you 
double-click an embedded object, such as the Total Yearly Sales chart, the source program 
opens within the destination document and allows you to make changes. In this example, 
Excel is the source program. 

Embedding an Excel Chart into a Word Document   INT 13

hyperlinks created, 
changing text to 
blue and underlined

To Start Excel and Open an Existing Workbook

The following steps open the Excel workbook in preparation for copying the chart 
from the workbook.

1  Start Excel. Click the Offi ce Button and then click Open on the Offi ce Button menu.

2  Click the Look in box arrow and then click UDISK 2.0 (E:) in the Look in list. (Your USB drive 
may have a different name and letter.)

3  Double-click Makin-It Real Estate Yearly Sales to open the Makin-It Real Estate Yearly Sales 
workbook.

Hyperlinks
Hyperlinks can link to 
both external locations 
and internal locations 
within the current 
document. To link to 
a location inside the 
current document, 
select the Place in This 
Document option in the 
Link to bar in the Insert 
Hyperlink dialog box. The 
Microsoft Offi ce 2007 
application then will 
provide a list of locations 
within the current 
document to which you 
can link. 

B
T
W

Embedded Objects 
The advantage of using 
an integrated set of 
applications, such as 
Microsoft Offi ce 2007, 
is the capability of 
sharing information 
among applications. 
The Object Linking 
and Embedding (OLE) 
features of Offi ce 2007 
make the integration 
process more effi cient. A 
chart created in Excel can 
be included in a Word 
document using OLE. 
To edit the embedded 
object, double-click it. 
The source program then 
starts and opens the 
source object for editing. 

B
T
W

C6169_INT_01.4c.indd   13C6169_INT_01.4c.indd   13 3/7/07   10:56:48 AM3/7/07   10:56:48 AM



INT 14   Integration Chapter 1   Integrating Offi ce 2007 Applications and the World Wide Web

To Embed an Excel Chart into a Word Document

The following steps embed the Excel Bar chart into the Word document.

1
• If necessary, click the 

Total Yearly Sales 
Chart tab to make 
the sheet tab active 
(Figure 1–11).

2
• Click the white area 

around the chart 
area to select the 
chart and then click 
the Copy button on 
the Ribbon to place 
a copy of the Bar 
chart on the 
Offi ce Clipboard 
(Figure 1–12).

Figure 1–11

Bar chart

Total Yearly Sales 
Chart sheet tab

Figure 1–12

Copy button

chart border changes to 
indicate chart selected
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3
• Click the Makin-It Real Estate 

Home Page button on the taskbar. 

• If necessary, click the right cell 
of the lower table to place the 
insertion point in the right cell 
of the table.

• Click the Home tab on the Ribbon.

• Click the Paste button arrow on 
the Ribbon to display the Paste 
gallery (Figure 1–13).

Figure 1–13

Paste button 
arrow

Paste gallery

Paste Special 
command

Embedding an Excel Chart into a Word Document   INT 15

4
• Click Paste Special to display the 

Paste Special dialog box. 

• If necessary, click Microsoft Offi ce 
Excel Chart Object in the As list 
(Figure 1–14).

Figure 1–14

OK button

Microsoft Offi ce 
Excel Chart Object

Paste Special 
dialog box

Paste option 
button selected
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INT 16   Integration Chapter 1   Integrating Offi ce 2007 Applications and the World Wide Web

Copy Methods
All Offi ce 2007 applications allow you to use three methods to copy objects among 

applications: (1) copy and paste; (2) copy and embed; and (3) copy and link. The fi rst 
method uses the Copy and Paste buttons. The latter two use the Copy button and the 
Paste Special command. Table 1–1 summarizes the differences among the three methods.

Table 1–1 Copy Methods

Method Characteristics

Copy and paste The source object becomes part of the destination document. An object may be edited, but 
the editing features are limited to those of the destination application. An Excel worksheet 
becomes a Word table. If changes are made to values in the Word table, any original Excel 
formulas are not recalculated. 

Copy and embed The source object becomes part of the destination document. An object may be edited in 
the destination document using source editing features. The Excel worksheet remains a 
worksheet in Word. If you make changes to values in the worksheet with Word active, Excel 
formulas will be recalculated. If you change the worksheet in Excel without the document 
open in Word, however, these changes will not display in the Word document the next time 
you open it.  

Copy and link The source object does not become part of the destination document, even though it appears 
to be. Instead, a link is established between the two documents, so that when you open the 
Word document, the worksheet displays within the document, as though it were a part of 
it. When you attempt to edit a linked worksheet in Word, the system activates Excel. If you 
change the worksheet in Excel, the changes also will display in the Word document the next 
time you open it. 

5
• Click the OK button 

to embed the Bar 
chart into the docu-
ment (Figure 1–15). 

Figure 1–15

Bar chart embedded in 
Word document table

Other Ways

1. Right-click object, 
on shortcut menu 
click Copy

2. Press CTRL+C

Objects
Objects can be nearly 
any part of an Offi ce 
2007 application or other 
Windows application. 
Some examples are Excel 
worksheets, a paragraph 
in a Word document, and 
a slide in a PowerPoint 
presentation. As long as 
you use the Paste Special 
command to paste data 
in the Clipboard, you can 
keep data in its native 
format. 

B
T
W
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To Change the Size of an Embedded Object

The embedded Bar chart slightly exceeds the margins of the Makin-It Real Estate Home Page document. 
Reducing the size of the Bar chart will improve the layout of the document. When an Offi ce 2007 document 
includes an embedded object from another Offi ce 2007 document, you can edit the object in place. When you 
edit an object in place, the destination document’s application displays commands on the Ribbon from the source 
document’s application. For example, when you edit the Total Yearly Sales chart in the Makin-It Real Estate Home 
Page, the Ribbon changes so that you can use commands from Excel even though you are working in Word. 

The following steps reduce the size of the chart by editing the object in place.

1
• Click the View Ruler 

button above the 
vertical scroll box. 

• If necessary, use the 
vertical scroll bar on 
the right side of the 
Word window to 
scroll to the top of 
the document.

• Drag the Move Table 
Column slider to the 
right so the border 
aligns with the 
left border of the 
upper table.

Embedding an Excel Chart into a Word Document   INT 17

2
• Right-click the Bar 

chart to display the 
shortcut menu. 

• Click Worksheet 
Object on the short-
cut menu to display 
the Worksheet 
Object shortcut 
menu and then point to 
the Edit command (Figure 1–16).

Figure 1–16

Edit command

View Ruler 
button

Worksheet 
Object command

Move Table 
Column slider

shortcut menu

column 1 of 
table resized
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4
• If necessary, use the 

scroll bars on the 
bottom and right 
sides of the Word 
window to scroll 
to the top of the 
document.

• Click next to the 
E-Mail for Information 
hyperlink in the fi rst 
column of the table 
to display the Word 
Ribbon (Figure 1–18).

Why did the Word 
Ribbon appear? 

When you are 
fi nished editing an 
embedded object in 
place, you can click 
anywhere outside 
the embedded 
object in the destina-
tion document to 
reactivate the desti-
nation document’s 
Ribbon commands. 

3
• Click Edit to begin 

editing the chart 
in place. 

• Click anywhere in the 
chart to select it.

• Use the scroll bars on 
the bottom and right 
sides of the Word 
window to scroll to 
the bottom-right of 
the chart.

• Drag the lower-right 
sizing handle of the 
chart up and to the 
left until the chart is sized as shown in Figure 1–17.

What happened to the Ribbon? 

When you edit an embedded object in place, the destination application, which is Word in this case, displays contextual 
commands in the Ribbon for the application in which the embedded object was created. You now can edit the Excel chart 
as though you are working in Excel. This method of editing is much simpler than the entire Excel application opening in 
order for you to edit the chart. 

Q
&

A
Q

&
A

Figure 1–18

Word Ribbon 
is displayed

chart resized

lower-right 
sizing handle of 
chart object

marquee surrounds 
chart to indicate the 
object being edited

Ribbon changes 
to Excel Ribbon

Offi ce Button 
disappears

Figure 1–17
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To Quit Excel

With the Bar chart embedded in the Word document, you no longer need the 
Makin-It Real Estate Yearly Sales workbook open. The following steps quit Excel.

1  Right-click the Microsoft Excel - Makin-It Real Estate Yearly Sales button on the taskbar. 
Click Close on the shortcut menu. If prompted to save changes, click the No button.

2  If the Microsoft Excel dialog box displays regarding saving the large amount of information 
on the Clipboard, click the No button.

Viewing the Word Document in Your Browser and Saving It as a Web Page   INT 19

Viewing the Word Document in Your Browser and 
Saving It as a Web Page
The next task is to view the Word document in your browser to verify that all information 
and links in the document are accurate. After verifying its accuracy, you then can save the 
Word document as an HTML fi le. Saving the Word document as an HTML fi le makes it 
possible for it to be viewed using a browser, such as Internet Explorer. 

To Add a Button to the Quick Access Toolbar

Many commands available in Word are not included on any of the tabs on the Ribbon. You can, however, 
add such commands to the Quick Access Toolbar. One such command allows you to preview a document in a Web 
browser. This command, Web Page Preview, needs to be added to the Quick Access Toolbar so that the Web page 
can be previewed. The following steps add the Web Page Preview command to the Quick Access Toolbar.

1
• Click the Customize Quick Access 

Toolbar button arrow to dis-
play the Customize Quick Access 
Toolbar menu (Figure 1–19). 

Figure 1–19

More Commands 
command

Customize Quick 
Access Toolbar 
button arrow

Customize Quick 
Access Toolbar menu

Resizing
To resize an image 
proportionally from a 
corner, you can press and 
hold down the SHIFT key 
while dragging a corner 
sizing handle. To resize 
vertically, horizontally, 
or diagonally from the 
center outward, press 
and hold down the CTRL 
key while dragging a 
sizing handle. To resize 
proportionally from the 
center outward, press 
and hold down the 
CTRL+SHIFT keys and drag 
a corner sizing handle.
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2
• Click the More 

Commands 
command on 
the Customize 
Quick Access 
Toolbar menu. 

• When the Word 
Options dialog box 
is displayed, click the 
‘Choose commands 
from’ box arrow to 
display the Choose 
commands from list 
(Figure 1–20). 

Figure 1–21

list of commands 
not in the Ribbon

Commands Not in 
the Ribbon selected

Figure 1–20

Choose commands 
from list

Commands Not in 
the Ribbon selection

Choose commands 
from box arrow

3
• Click Commands Not 

in the Ribbon in the 
‘Choose commands 
from’ list to display 
a list of commands 
not in the Ribbon 
(Figure 1–21). 
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1Viewing the Word Document in Your Browser and Saving It as a Web Page   INT 21

4
• Scroll to the bottom 

of the list, click Web 
Page Preview, and 
then click the Add 
button to add the 
button to the Quick 
Access Toolbar 
(Figure 1–22). 

5
• Click the OK button to close 

the Word Options dialog box 
(Figure 1–23). 

Will the Web Page Preview 
command be on the Quick Access 
Toolbar the next time that I 
start Word?

Yes. When you change the Quick 
Access Toolbar, the changes remain 
even after you restart Word. If you 
share a computer with somebody 
else or if the Quick Access Toolbar 
becomes cluttered, Word allows 
you to remove commands from 
the Quick Access Toolbar. The Web 
Page Preview button is removed 
from the Quick Access Toolbar 
later in this chapter. 

Figure 1–23

Web Page Preview 
button added to 
Quick Access Toolbar

Q
&

A

Figure 1–22

OK button

Add button

Web Page Preview  
command added 
to Quick Access 
Toolbar list
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To Preview the Web Page

The following steps preview the document in the browser and then save the Word document as an HTML fi le.

1
• Click the Web Page 

Preview button on 
the Quick Access 
Toolbar to display 
the Web page in 
your browser. 

2
• If necessary, click the 

Maximize button on 
your browser’s title 
bar (Figure 1–24).

3
• Click the browser’s 

Close button.

How should I verify 
the Web page?

Verify that the Web 
page contains 
all information 
necessary and is 
displayed as shown 
in Figure 1–24. The 
Web page consists of 
a heading with logo 
images and the company 
name, address, and telephone number. A borderless table displays three hyperlinks in the left column and a Bar chart in 
the right column. The E-Mail for Information hyperlink should display a new message when you click it. The other two 
links, Company Services and Homes for Sale, do not work because the corresponding Web pages are not available until 
later in this chapter. 

To Save a Document with a New File Name

If the Web page is correct, save it on the USB fl ash drive as an HTML fi le. If 
changes need to be made to the Web page, return to the Word document and correct it. 
The following steps save the document as a Web page.

1  Click the Offi ce Button and then click the Save As command. 

2  Type Makin-It Real Estate Home Page in the File name text box if necessary.

3  Select Web Page in the Save as type box.

4  If necessary, click the Save in box arrow and then click UDISK 2.0 (E:) in the Save in list. 
(Your USB fl ash drive may have a different name and letter.)

Figure 1–24

e-mail hyperlink

embedded Bar chart

Close button

two hyperlinks to 
other Web pages

logo images

heading

Q
&

A

Web Page Formatting 
Because Word provides 
formatting options that 
most Web browsers do 
not support, some text 
and graphics may look 
different when you 
view them on a Web 
page. When creating 
documents for the Web, 
using Web layout view 
will ensure that your 
graphics look the way 
you want them to when 
they are viewed as Web 
pages in a Web browser.
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1Creating a PowerPoint Presentation Web Page   INT 23

5  Click the Save button in the Save As dialog box. If the Microsoft Offi ce Word dialog box 
displays, click the Continue button.

Why should I save the document as a Web page? 

Saving an existing Word document as a Web page allows you quickly to get a Word 
document ready for copying to the Web or to an intranet. One alternative to this is to 
write the Hypertext Markup Language (HTML) to develop the Web pages. HTML is a 
programming language used for Web page creation. The home page created earlier in 
this chapter could be created by writing HTML tags (code). For documents that already are 
in Word format, the easier method is to use the Word Save as Web Page command. This 
essentially creates the HTML code for you and saves it in a fi le. While the HTML code is in 
the fi le, you do not need to understand HTML code. 

To Reset the Quick Access Toolbar and Quit Word

The necessary work with the Word document is complete. The following steps 
remove the Web Page Preview button from the Quick Access Toolbar and quit Word.

1  Click the Customize the Quick Access Toolbar button arrow on the Ribbon.

2  Click the More Commands command.

3  When the Word Options dialog box is displayed, click the Reset button. If the Reset 
Customizations dialog box is displayed, click the OK button.

4  Click the OK button on the Word Options dialog box to close it.

5  Click the View Ruler button to close the ruler.

6  Click the Close button on the Microsoft Word title bar.

Do I need to remove the button from the Quick Access Toolbar? 

No. For consistency with this book, reset the Quick Access Toolbar after the added buttons 
are no longer needed. If you share a computer with others, you should reset the Quick 
Access Toolbar when you are fi nished using the computer. 

Creating a PowerPoint Presentation Web Page
PowerPoint 2007 allows you to create Web pages from an existing PowerPoint presentation, 
using the same method used earlier in this chapter to save a Word document as a Web page. 
The presentation then can be viewed using your browser. 

To Start PowerPoint and Open an Existing Presentation

The PowerPoint presentation used in this chapter consists of three slides 
(Figure 1–1g on page INT 5). The fi rst slide is a title slide, containing the company name 
and graphics. Slide 2 consists of information about services for home sellers. Slide 3 includes 
information about services for home buyers. This information can be used in its present 
format to enhance a presentation about the company’s services. As Web pages, you can use 
this presentation to address a much wider, global audience on the World Wide Web.

Q
&

A
Q

&
A

Web Programming 
Languages 
A number of 
programming languages 
can be used to create 
Web pages. Web pages 
created using the Save 
as Web Page command 
on the File menu can 
be enhanced with other 
Web programming 
languages, such as ASP, 
DHTML, and JavaScript.
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The following steps open an existing PowerPoint presentation.

1  Start PowerPoint. Click the Offi ce Button and then click Open on the Offi ce Button menu.

2  Click the Look in box arrow and then click UDISK 2.0 (E:) in the Look in list. (Your USB drive 
may have a different name and letter.)

3  Double-click Makin-It Real Estate Presentation to open the Makin-It Real Estate 
Presentation presentation (Figure 1–25).

Figure 1–25

Slide 1 of PowerPoint 
presentation

slides in 
presentation

To Add Text for a Hyperlink into a PowerPoint Presentation

One of the more important features of Web sites is their capability of linking from 
one Web page to another using hyperlinks. In earlier steps in this chapter, you added 
three hyperlinks to the Makin-It Real Estate home page. Once Web page visitors link to 
the PowerPoint Web pages, however, they cannot return to the home page without using 
the Back button on the browser’s toolbar. This is not a convenient way for Web page visi-
tors to navigate through the Web site. The following steps add a Home link to the fi rst 
slide of the PowerPoint presentation (Figure 1–1e on page INT 5).

1  Click the Insert tab on the Ribbon.

2  Click Text Box on the Ribbon.

Keeping Links Fresh 
When you create a Web 
page, it is important to 
make sure that all of your 
hyperlinks are functional 
as time goes on. Links to 
other pages can become 
stale, or nonfunctional, 
if another Web page 
creator or an external 
site takes a page offl ine. 
Automated tools can 
help you identify when 
pages to which you are 
hyperlinking no longer 
are available.
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1Creating a PowerPoint Presentation Web Page   INT 25

3  Draw the outline of the text box in the location shown on the slide in Figure 1–26.

4  If necessary, click inside the text box. 

5  Type Home as the hyperlink text (Figure 1–26).

Figure 1–26

text for 
hyperlink

text box

Other Ways

1. Press ALT+N, press X

To Insert a Hyperlink into a PowerPoint Presentation

After you enter the text for the hyperlink, you can create the hyperlink itself. When clicked, the hyperlink 
jumps to the Makin-It Real Estate home page created previously in this chapter and saved on the USB fl ash drive. To 
create the hyperlink, you will use the Hyperlink button on the Insert tab on the Ribbon. 

The following steps create the PowerPoint hyperlink.

1
• Double-click the word, Home, 

inside the text box you just 
inserted.

2
• If necessary, click the Insert tab on 

the Ribbon.

• Click the Hyperlink button on 
the Ribbon to display the Insert 
Hyperlink dialog box.

3
• If necessary, click the Existing File or 

Web Page button on the Link to bar. 

• Type e:\Makin-It Real Estate 
Home Page.htm in the Address 
text box. (Your USB drive may have 
a different name and letter.) Click the OK button to add the hyperlink to the text in the 
text box (Figure 1–27).

Figure 1–27

text changed 
to hyperlink

Other Ways

1. Right-click highlighted 
word, click Hyperlink 
on shortcut menu

2. Press CTRL+K
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To Add a Button to the Quick Access Toolbar and View the Web 
Page in Your Browser

Just as in the previous section of this chapter, the following steps display the Web 
page before saving it. It is important to verify all of the Web page navigation features 
before saving the fi le. Because the Web Page Preview button is not available on the 
Ribbon, the button must fi rst be added to the Quick Access Toolbar.

1  Click the Customize Quick Access Toolbar button arrow to display the Customize Quick 
Access Toolbar menu.

2  Click the More Commands command on the Customize Quick Access Toolbar menu.

3  When the PowerPoint Options dialog box is displayed, click the ‘Choose commands from’ 
box arrow to display the Choose commands from list.

4  Click Commands Not in the Ribbon in the Choose commands from list to display a list of 
commands not in the Ribbon. Scroll to the bottom of the list, click Web Page Preview, and 
then click the Add button to add the button to the Quick Access Toolbar.

5  Click the OK button to close the PowerPoint Options dialog box.

6  Click the Web Page Preview button on the Quick Access Toolbar to display the Web page 
in your browser. 

7  If necessary, click the Maximize button on your browser’s title bar (Figure 1–28).

Figure 1–28

text hyperlink

outline with 
text hyperlinks

Expand/Collapse 
Outline button
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1Creating a PowerPoint Presentation Web Page   INT 27

Using Hyperlinks in PowerPoint
Slide 1 of the PowerPoint presentation Web page contains a hyperlink to the home 

page of the Makin-It Real Estate Web site. Although you created this hyperlink by adding 
a text box to the fi rst slide, you also can create hyperlinks from existing text or images in a 
PowerPoint presentation. For example, one of the logo images on slide 1 could be used as a 
hyperlink to the home page of the Web site. Using one of those images, however, does not 
give the Web page visitor a clear idea of where the hyperlink will lead. It is more appropriate 
to create a hyperlink to the home page from text — for example, Home — that makes sense 
to the visitor.

In addition to any hyperlinks that are added to the presentation, PowerPoint 
automatically creates hyperlinks in the left column of the Web page, called the outline. 
Using the Expand/Collapse Outline button below the outline pane, you can expand or 
collapse the outline and navigate through the Web page presentation (Figure 1–28). The 
text in the heading of each slide is used as the phrases for these hyperlinks. When you 
click a link, you jump to that particular slide within the presentation. The ease of 
navigation within a PowerPoint Web page is valuable to the Web page visitor.

To Save the PowerPoint Presentation as a Web Page

The next step is to save the PowerPoint presentation as a Web page. When 
you save a PowerPoint presentation as a Web page, the Web page is saved in a default 
folder. All supporting fi les, such as backgrounds and images, are organized in this folder 
automatically. The name of the PowerPoint slide show opened in this section is Makin-
It Real Estate Presentation. To simplify the naming of the Web page, the Web page will 
be saved with the name CompanyServices.htm. PowerPoint uses the name of the saved 
Web page and adds the string, _fi les, for the name of the new folder. When saving the 
current presentation as a Web page, the folder name that PowerPoint Web creates is 
CompanyServices_fi les. The default name for the fi rst slide in the presentation is frame.htm. 
The structure used in the folder organization makes Web page publishing easier because 
you can keep track of all of the fi les associated with the Web page. You also can edit the 
fi les manually, rather than using PowerPoint.

The steps below save the PowerPoint presentation as a Web page.

1  Click the Microsoft PowerPoint button on the taskbar.

2  Click the Offi ce Button and then click the Save As command.

3  If necessary, type CompanyServices in the File name text box.

4  Select Web Page in the ‘Save as type’ box.

5  If necessary, click the Save in box arrow and then click UDISK 2.0 (E:) in the Save in list. 
(Your USB fl ash drive may have a different name and letter.)

6  Click the Save button in the Save As dialog box to save the PowerPoint presentation as a 
Web page.

Web Page Publishing 
The Web pages created in 
this project all are stored 
locally on your computer. 
Typically, a Web page 
must be published 
to a server inside the 
organization or at your 
ISP. Microsoft offers a 
Web Page Publishing 
Wizard to assist in 
moving all of the related 
fi les and directories that 
comprise a Web site. 

B
T
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Outline
The outline pane is 
displayed by default 
when you view a 
presentation in a 
browser. To hide this 
pane, click the Outline 
button while in the 
browser. Click the Outline 
button again to redisplay 
the outline pane. 
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To Remove a Button from the Quick Access Toolbar, Quit 
PowerPoint, and Close Your Browser

After saving the PowerPoint presentation as a Web page, you can remove the Web 
Page Preview button from the Quick Access Toolbar, quit PowerPoint, and close your 
browser, as shown in the following steps. 

1  Click the Customize the Quick Access Toolbar button arrow on the Ribbon.

2  Click the More Commands command.

3  When the PowerPoint Options dialog box is displayed, click the Reset button. If the Reset 
Customizations dialog box is displayed, click the OK button.

4  Click the OK button on the PowerPoint Options dialog box to close it.

5  Click the Close button on the PowerPoint title bar.

6  Click the Close button on the browser title bar.

Creating a Web Page from an Access Report
The next task in the Makin-It Real Estate Web site creation is to use an Access database to 
create a report and save it as a Web page. One of the more common purposes of reports 
is for viewing records in a database via a company’s intranet or the World Wide Web. 
Reports provide a method to make inquiries of large amounts of data in a selective way. 

To Start Access and Open an Existing Database

The following steps open an Access database.

1  Start Access. Click the Offi ce Button and then click Open on the Offi ce Button menu.

2  Click the Look in box arrow and then click UDISK 2.0 (E:) in the Look in list. (Your USB drive 
may have a different name and letter.)

3  Double-click Makin-It Real Estate Homes for Sale to open the Makin-It Real Homes for Sale 
database (Figure 1–29).

Figure 1–29

Homes For 
Sale table

Viewing Web Pages 
In addition to Microsoft 
Windows environments, 
many environments 
exist for viewing Web 
pages. When creating 
a Web page with 
special features, such 
as data access pages, it 
is important to make 
sure that the special 
features are supported 
within the environment 
in which the Web page 
viewers operate. For 
example, users who view 
Web pages on Apple 
Macintosh computers 
may have a different 
Web page viewing 
experience. 
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1Creating a Web Page from an Access Report   INT 29

2
• Click the Next button. 

• Click Style in the box on the 
left and then click the Add but-
ton to group the report by Style 
(Figure 1–31).

To Create a Report Using the Report Wizard

For the Makin-It Real Estate Web site, you do not want the database to be altered by the Web page visitor 
in any way. The visitors should be allowed to view only the data. Creating an Access report and then publishing the 
report as a Web page will achieve this goal. The Web page visitors can view all data, but they cannot change the data 
itself. 

The following steps create a new Access report.

1
• Click the Create tab 

on the Ribbon.

• Click the Report 
Wizard button on 
the Ribbon.

• When the Report 
Wizard dialog box is 
displayed, click the 
Add All Fields button 
to move all the fi elds 
in the table to the 
Selected Fields list 
(Figure 1–30).

Figure 1–30

Add All 
Fields button

all fi elds in Homes For 
Sale table selected

Report Wizard 
dialog box

Next button

Create tab

Report Wizard 
button

Figure 1–31

Next button

Add button
report to be 
grouped by Style
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3
• Click the Next button to display 

options for sorting records 
(Figure 1–32). 

Figure 1–32

Next button

4
• Click the Next button.

• Click the Landscape option button 
in the Orientation area to select it 
(Figure 1–33). 

Why change the orientation to 
landscape?

When you plan to use a report as 
a Web page, set the orientation 
to landscape so that the report 
takes up as much horizontal space 
as possible. If portrait is selected, 
then the Web page visitor might 
see a large empty margin on the 
right side of the page. 

Figure 1–33

Next button

Landscape 
option button

Q
&
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1Creating a Web Page from an Access Report   INT 31

5
• Click the Next button.

• If necessary, click the Access 2007 
style in the list on the right 
(Figure 1–34). 

Figure 1–34

Next button

Access 2007 
style selected

6
• Click the Next button and 

then type Makin-It Real 
Estate – Homes For Sale in 
the ‘What title do you want for 
your report?’ text box. 

• If necessary, click the ‘Modify the 
report’s design’ option button to 
select it  (Figure 1–35).

Figure 1–35

new page 
title entered

Modify the 
report’s design 
option button

Finish button
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7
• Click the Finish 

button to display 
the report in Design 
view (Figure 1–36). 

• If necessary, close the 
Field List task pane.

Figure 1–36

report in 
Design view

=Now() function 
in Page Footer

To Add a Hyperlink to a Report and Change the Text Background Color

Just as you did on the PowerPoint Web page, you should add a hyperlink on the report that links to the home 
page. This allows the Web page visitor to return to the Makin-It Real Estate home page without having to click the 
Back button on the browser’s toolbar repeatedly. When you plan to save a report as a Web page, the background 
color of the elements of the Web page – such as the report title, column titles, and rows – should be changed to a 
light color, such as white. Browsers do not properly interpret some default colors used by Access for the background 
colors. The following steps add a hyperlink to the report and change the background colors of the elements in the 
report to white.

1
• Click the rightmost 

text box in the Page 
Footer area of the 
report to select it. 

• Press the DELETE 
key to delete the
text box.

• Click the leftmost 
text box in the Page 
Footer area of the 
report to select it. 

• Press the DELETE key to 
delete the text box that contains the NOW() function (Figure 1–37).

Why should I delete these items?

The report will be saved as a Web page. Web pages should not include page footer items such as page numbers because 
when the report is displayed in a Web browser, it will display as one long continuous page in the browser. There will 
never be a second page in the Web browser. A report footer, therefore, would be a good design choice, but not a page 
footer. 

Figure 1–37 

Q
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2
• Click the Insert 

Hyperlink button on 
the Ribbon to display 
the Insert Hyperlink 
dialog box.

• If necessary, click the 
Existing File or Web 
Page button in the 
Link to bar.

• Click the ‘Text to 
display’ text box and 
then type Home as 
the text to display 
for the hyperlink.

• Click the Address 
box and then type 
e:\Makin-It 

Real Estate 

Home Page.htm 
(Figure 1–38).

Figure 1–38 

OK button

Address box

Insert Hyperlink button

Text to display  
text box

Insert Hyperlink 
dialog box

3
• Click the OK button to insert the 

hyperlink (Figure 1–39).

Figure 1–39 

hyperlink added 
to report

Creating a Web Page from an Access Report   INT 33
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4
• Drag the hyperlink to the lower-

left corner of the Page Footer area 
of the report (Figure 1–40). 

Figure 1–40

hyperlink properly 
positioned in Page 
Footer area

5
• Click anywhere in the 

Style header in the 
Page header area to 
select it.

• Click the Plus icon in 
the upper-left corner 
of the Style header 
to select all items 
in the body of the 
report (Figure 1–41). 

Figure 1–41

upper-left corner of 
Style header in Page 
Header area

all items in report 
body selected
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6
• Click the Fill/Back 

Color button arrow 
on the Ribbon and 
then click the White 
color (column 1, 
row 1) in the Standard 
Colors area of the 
Fill/Back Color 
palette to change 
the background 
color of the selected 
items to white.

• Click the report 
title in the Report 
Header area.

• While holding down 
the SHIFT key, click 
the Home hyperlink 
in the Page Footer 
area to select it.

• Click the Fill/Back 
Color button on the 
Ribbon to change 
the background 
color of the selected 
items to white 
(Figure 1–42). 

Why should I change 
the background 
color of these items?

Some items do not 
properly display when a Microsoft Access report is saved as a Web page. These items were transparent by default. The Web 
browser cannot understand transparency. By assigning a background color, you avoid this problem.

Figure 1–42

Fill/Back Color 
button arrow

background color 
changed to white for 
all items in report

Q
&

A
Creating a Web Page from an Access Report   INT 35
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To Save the Report and View It in Your Browser

In other sections of this chapter, you have viewed the Web page, verifi ed that it is correct, and then saved it on 
a USB fl ash drive. Unlike Word and PowerPoint, you must save a report as a Web page before you can preview it in 
your browser. 

1
• Right-click the Makin-It Real 

Estate - Homes For Sale report in 
the All Tables list. 

• Point to the Export command on 
the shortcut menu (Figure 1–43).

Figure 1–43 

shortcut menu

HTML Document 
command

Export 
command

Makin-It Real 
Estate - Homes 
For Sale report

2
• If necessary, click 

Export, then click 
HTML Document.

• When the Export -
HTML Document 
dialog box is 
displayed, 
double-click the 
File name text 
box and then type 
E:\Makin-It Real 

Estate - Homes 

For Sale.html as 
the fi le name.

• Click the ‘Open the 
destination fi le after 
the export opera-
tion is complete’ 
check box to select it  
(Figure 1–44).

Figure 1–44 

OK button

fi le name text box

check box selected

Export – HTML 
Document dialog box
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3
• Click the OK button.

• When the HTML Output Options dialog box is displayed, click the OK button to open the report in your browser 
(Figure 1–45).

Figure 1–45 

To Close Your Browser and Quit Access

After you preview the report in your browser, you can close your browser and quit 
Access, as shown in the following steps. 

1  Click your browser’s Close button. 

2  If the Export – HTML Document dialog box is displayed, click the Close button. 

3  Click the Close button on the Access title bar to quit Access. Save changes to the report if 
you are prompted to save the changes.

Creating a Web Page from an Access Report   INT 37
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Testing the Web Site
The Makin-It Real Estate Web site is complete. To ensure that all the links in the Web 
site are viable, the following steps open the home page and then thoroughly test the entire 
Web site.

To Test the Web Site

1  Start your browser.

2  Click the Address bar of your browser.

3  Type e:\Makin-It Real Estate Home Page.htm in the Address bar, and then press 
the ENTER key to display the home page of the Makin-It Real Estate Web site in your 
browser (Figure 1–46).

Figure 1–46
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To Verify the Hyperlinks

All hyperlinks should be tested by clicking them and verifying that they jump to the 
correct Web page. Three hyperlinks are on the home page: Company Services, Homes for 
Sale, and E-Mail for Information. The following steps test the links.

1  Click the Company Services hyperlink.

2  Click the navigation buttons to view all slides on the Web page.

3  On the fi rst slide on the PowerPoint Web page, click the Home hyperlink.

4  Click the Homes for Sale hyperlink. 

5  On the Access report page, click the Home hyperlink.

6  Click the E-Mail for Information hyperlink to display a new e-mail message with 
manager@isp.com in the To text box.

To Quit E-Mail and Close Your Browser

With the hyperlinks verifi ed, the steps on the next page quit the e-mail program and 
the browser.

1  Click the Close button on your e-mail program‘s title bar. Click No if asked to save changes.

2  Click the Close button on your browser’s title bar.

Testing the Web Site   INT 39
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Chapter Summary
This chapter introduced you to integrating Microsoft Offi ce 2007 applications. You opened an existing Word 
document and created a two-column, one-row, borderless table. You then inserted three hyperlinks, embedded a 
Bar chart from an existing Excel worksheet, and saved that document as an HTML fi le. You then opened an existing 
PowerPoint presentation, added a hyperlink to the fi rst slide, and saved this presentation as a Web page. Finally, you 
opened an existing Access database and created a report, which you saved as a Web page. You saved that report and 
viewed and tested all Web pages and hyperlinks. The items listed below include all the new Offi ce 2007 skills you 
have learned in this chapter.

 1. Insert a Table into a Word Document (INT 8)
 2. Remove the Table Border, View Gridlines, and 

AutoFit the Table Contents (INT 9)
 3. Insert Text for Hyperlinks (INT 11)
 4. Create a Hyperlink to PowerPoint Web Pages 

(INT 11)
 5. Embed an Excel Chart into a Word Document 

(INT 14)
 6. Change the Size of an Embedded Object (INT 17)
 7. Add a Button to the Quick Access Toolbar 

(INT 19)

 8. Preview the Web Page (INT 22)
 9. Insert a Hyperlink into a PowerPoint Presentation 

(INT 25)
 10. Create a Report Using the Report Wizard 

(INT 29)
 11. Add a Hyperlink to a Report and Change the Text 

Background Color (INT 32)
 12. Save the Report and View It in Your Browser 

(INT 36)

Learn It Online

Learn It Online is a series of online student exercises that test your knowledge of chapter 
content and key terms.

Instructions: To complete the Learn It Online exercises, start your browser, click the Address bar, and then 
enter the Web address scsite.com/int2007/learn. When the Integration 2007 Learn It Online 
page is displayed, click the link for the exercise you want to complete and then read the instructions.

Chapter Reinforcement TF, MC, and SA
A series of true/false, multiple choice, and short 
answer questions that test your knowledge of the 
chapter content. 

Flash Cards
An interactive learning environment where 
you identify chapter key terms associated with 
displayed defi nitions. 

Practice Test
A series of multiple choice questions that test your 
knowledge of chapter content and key terms. 

Who Wants To Be a Computer Genius?
An interactive game that challenges your 
knowledge of chapter content in the style of a 
television quiz show.

Wheel of Terms
An interactive game that challenges your 
knowledge of chapter key terms in the style of the 
television show Wheel of Fortune.

Crossword Puzzle Challenge
A crossword puzzle that challenges your 
knowledge of key terms presented in the chapter. 
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Figure 1–47

Continued >

In the Lab

Create a workbook using the guidelines, concepts, and skills presented in this chapter. Labs 
are listed in order of increasing diffi culty.

Lab 1: Creating a Web Page in Word with an Embedded Excel Chart
Problem: As vice president of Calamity Jack’s Home Disaster Recovery Service, you have created a 
worksheet and chart in Excel to analyze the sales for the past year. Create a Web page in Word and 
embed the chart from the Calamity Jack’s Sales workbook on the home page. Add a link to a second 
Web page and an e-mail link to calamityjacks@isp.com below the chart. Create a second Web page in 
Word by embedding the Calamity Jack’s Sales worksheet. 

Instructions: Perform the following tasks.
 1. Start Excel by opening the Lab 1-1 Calamity Jack’s Sales workbook.

 2. Start Word and create a new document in Web Layout view. Add a title and subtitle as shown 
in the Web page preview of the document in Figure 1–47. Select the chart in Excel from the 
Yearly Sales Chart worksheet, copy it, and use the Paste Special dialog box in Word to embed the 
Microsoft Offi ce Excel Chart Object. Resize the chart so that it fi ts in the Word window without 
the need to scroll to see the right edge of the chart. 
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In the Lab

Lab 2: Posh Limousine Rental Web Site with an Access Report and an Excel Worksheet
Problem: As the assistant manager of Posh Limousine Services, Matt Ruginis is responsible for 
keeping track of limousines that are rented on a per-day basis. He would like you to design a site 
that allows customers to view the availability of limousines for rent. He also wants an e-mail link for 
customer questions.

Instructions: Perform the following tasks.
 1. Start Word. Create a home page for the Post Limousine Availability Web site (Figure 1–49). Add 

a title and a borderless table below the title. In the left column, insert three hyperlinks. The fi rst 
hyperlink should go to Lab_1-2_LimousineList.htm (Figure 1–50). The second hyperlink should go 
to Lab_1-2_LimousineAvailability.htm (Figure 1–51 on page INT 44). The third hyperlink should 
start an e-mail message to assistantmanager@isp.com. Type the text in the right column. Save the 
Web page as Lab_1-2_PoshLimousineServices.htm.

INT 42   Integration Chapter 1   Integrating Offi ce 2007 Applications and the World Wide Web

Figure 1–48

In the Lab continued

 3. Add two hyperlinks to the bottom of the page in a centered table as shown in Figure 1–47. The 
fi rst hyperlink should jump to the Web page Lab_1-1_CalamityJacksSales.htm, which is created 
next. The second hyperlink creates an e-mail message to calamityjacks@isp.com with the subject 
About Our Company. 

 4. Save this fi le as a Web page named Lab_1-1_CalamityJacks.htm.

 5. Create a new document in Word in Web Layout view.

 6. Embed the Excel worksheet into the Word page. That is, switch to Excel, select the worksheet 
named Yearly Sales Analysis, select and copy the worksheet to the Clipboard, switch to Word, and 
use the Paste Special command in the Paste gallery in Word to embed the Excel Worksheet Object.

 7. Save this fi le as a Web page with the name Lab_1-1_CalamityJacksSales.htm.

 8. View the Lab_1-1_CalamityJacks.htm fi le in your browser (Figure 1–47). Print the Web page. 
Click the Yearly Sales link to navigate to the Lab_1-1_CalamityJacksSales.htm page (Figure 1–48).

C6169_INT_01.4c.indd   42C6169_INT_01.4c.indd   42 3/7/07   10:57:39 AM3/7/07   10:57:39 AM



In the Lab   INT 43

In
te

g
ra

ti
o

n
 C

h
ap

te
r 

1
S

T
U

D
E

N
T
  

A
S

S
IG

N
M

E
N

T
S

Figure 1–49

Figure 1–50

Continued >

 2. Start Access by opening the Lab 1-2 LimousineList.mdb database on the Integration Data Disk. 
Create an Access Report saved as a Web page from the LimousineList table. Create a grouping 
level using the Hourly Rental Allowed fi eld. Add a title as shown in Figure 1–50. Add a link named 
Home that links to the Lab_1-2_PoshLimousineServices.htm home page at the bottom of the 
Access Report Web page. Save the Access Report Web page as Lab_1-2_LimousineList.

 3. Start Excel by opening the Lab 1-2 LimousineAvailability workbook on the Integration Data Disk. 
Create a Web page from the workbook by using the Save As command on the Offi ce Button menu 
and choosing Web Page as the fi le type. Use the fi le name, Lab_1-2_LimousineAvailability.htm.

 4. View the Lab_1-2_PoshLimousineServices.htm Web page in your browser. Verify that all links 
operate properly by clicking each one. 
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In the Lab continued

Figure 1–51

In the Lab

Lab 3: Web Site Incorporating PowerPoint Web Pages
Problem: As a part time employee with the Village of Harrust, you have been asked to create a 
Web page that publicizes the village’s summer intern program (Figures 1–52 and 1–53). The specifi c 
information for the internships is located in a PowerPoint presentation, which has four pages.

Instructions: Perform the following tasks.
Start Word. Create the Web page as shown in Figure 1–52. Insert two hyperlinks. The fi rst 

hyperlink should link to Lab 1-3 Village of Harrust Internships.htm, and the second should link to an 
e-mail address at manager@vilharrust.gov. Use clip art to insert the picture of a municipal building. 
Save this Web page as Lab_1-3_VillageofHarrustHomePage.htm.
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Open the Lab 1-3 PowerPoint presentation Lab 1-3 Village of Harrust Internships. Add a 
link named Home at the bottom of the fi rst page of the presentation that jumps to the Lab_1-3_
VillageofHarrustHomePage.htm Web page. Save the PowerPoint presentation as Web pages on the 
Integration Data Disk. Name the Web pages Lab 1-3 Village of Harrust Internships.htm. View the 
Web pages in your browser. 
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Figure 1–52

Figure 1–53
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Cases and Places

Apply your creative thinking and problem solving skills to design and implement a solution. 

• EASIER    •• MORE DIFFICULT

• 1: Design and Create a Lawn Care Service Web Site
During your summer break, you and your friends decide to get your exercise by providing lawn care 
services for local residents and businesses. You plan to offer four services, each at a different rate. To 
mow a small yard with push mowers, you will charge $15 per week for each quarter acre. To mow a 
large yard with riding mowers, you will charge $22 per week for each quarter acre. To provide weeding 
and tree pruning, you will charge $20 per week. Additional lawn care service, including dethatching 
and fertilizing, will cost $50 for the summer per quarter acre. Create a worksheet in Excel that 
summarizes each of these plans. Create a Web page using Word that embeds the Excel worksheet; 
the goal of the Web site is to inform new customers of the services provided. Make sure to include an 
e-mail address on the Web page.

• 2: Analyze the Cost of Internet Access in a Web Page
You have been asked to research the cost of various types of Internet access for local small businesses. 
Research the different types of Internet access available to small businesses in your area, and determine 
the following for each: service provider name, service level, speed, contact name, contact telephone 
number, contract restrictions, and costs. Create an Excel worksheet and charts summarizing your data 
and graphing the speed and costs for each service provider. Using Word, create a Web page and embed 
the worksheet on the home page of the Web site. Create another Web page, and embed the chart(s) 
from Excel. Create a link to the Excel chart(s) Web page and a link to each service provider’s Web page.

•• 3: Design and Create a Customer Complaint Web Page
Your housing association has asked you to help to organize and evaluate complaints from residents. 
Create an Access database and add eight items to it with the following information for each complaint: 
complaint number, resident ID number, type of complaint, description, date of complaint, resolution 
date of the complaint, name of staff member who resolved the complaint, and how the complaint was 
resolved. From this table, create an Access report saved as a Web page using the type of complaint as 
the grouping level. Include all of the items in the Access database in the Web page. Use a search engine 
to fi nd relevant links about each type of complaint – such as drainage, landscaping, and noise – that are 
relevant to housing associations, and create links to one Web page each for each category at the bottom 
of the Access report Web page.

•• 4: Design and Create a Summer Internship Web Site

Make It Personal 
As an intern for your school’s placement program, you have been asked to create a Web page on 
which students can view information about summer internships available in the local area. Using 
your own fi eld of interest as a guide, create an Access database and add information to the database 
about prospective summer internships regarding your area of interest. Include the following fi elds: 
organization name, preferred major, type of job, job description, number of positions available, and 
whether the organization has participated in an internship program in the past. From this table, create 
an Access report and save it as a Web page using the preferred major as the grouping level. Create a 
Web page using Word that will act as the Web page for the organization list and create a link to the 
Access report Web page. Be sure to include a link to your e-mail address on the Web page.
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•• 5: Design and Create an Informational Web Site about a Foreign Country

Working Together
Gather basic statistical data about a foreign country, including population, important business and 
industry, and other demographic data. Have one member of your team create an Excel 3-D Pie chart 
to summarize the demographic information that you fi nd. Have another member create a PowerPoint 
presentation that contains at least four major points regarding the country that may make the country 
interesting to potential visitors, including information about business and industry. A third member 
should create an Access report saved as a Web page that includes information about popular tourist 
destinations in the country. Embed the Excel chart into one of the PowerPoint slides. Create a link 
from one of the PowerPoint pages to the Access report Web page. Save the PowerPoint presentation 
as Web pages. Include relevant links to Web pages regarding the country.
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